Release Notes for Nuke
8.0v7b16

Release Date
17 February 2014

Qualified Operating Systems
• Mac OS X 10.7 (Lion), 10.8 (Mountain Lion), 10.9 (Mavericks)
NOTE: Nuke is expected to function correctly under Mac OS X 10.9 (Mavericks), but we are seeing UI
performance degradation compared to previous OS X versions. We are working on resolving these issues.
• Windows 7 64-bit and Windows 8 64-bit
• CentOS/RHEL 5 and CentOS/RHEL 6
Other operating systems may work with Nuke, but have not been fully tested. If you have any problems with a
particular operating system, please contact support@thefoundry.co.uk.

Requirements for GPU Acceleration
To take advantage of GPU acceleration, you must have:
• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is
available at www.nvidia.co.uk/object/cuda_gpus_uk.html.
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software
update.
• graphics drivers capable of running CUDA 4.2 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU.
Drivers from April 2012 onward support CUDA 4.2.
Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it
already. The minimum requirement for CUDA 4.2 is driver version 4.2.5 which can be downloaded from
www.nvidia.com/drivers.
NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 41542/46682/47405/47406 - Alembic: Importing cameras now runs a post-processing Euler filter to look
for alternate sets of Euler angles that result in the same orientation, and chooses the set which most closely
matches the angles from previous frames.
• BUG ID 40604/46547 - Alembic: A new preference, always load abc files as all-in-one, has been added under
Windows > Alembic. When enabled, all nodes in an .abc file are automatically imported, with all alembic geometry
nodes imported into a single ReadGeo node.
• BUG ID 46192 - ScannedGrain: A new control, use precomputed table, has been added to the ScannedGrain
properties. This control is enabled by default for backward compatibility, but you can disable it to stop Nuke
clamping the LUT to values between 0 and 1.

Bug Fixes
• BUG ID 13927 - Read: The missing frames dropdown did not work consistently in branching node trees.
• BUG ID 38192/46282 - Alembic: Nuke did not accept a frame rate other than 24 fps for Alembic files exported
from Maya 2014.
• BUG ID 40321 - LensDistortion: Camera presets, set using the wrench icon in the Properties panel, could not be
shared between Nuke 7 and Nuke 8.
• BUG ID 41080 - Viewer: Ctrl/Cmd+clicking outside the bounding box and then panning or zooming the Viewer
caused Nuke to crash.
• BUG ID 41334 - Alembic: Rendering from the command line with Read from file enabled in the Camera properties
and partial geometry selected in a ReadGeo node, caused Nuke to crash.
• BUG ID 41932 - RotoPaint: Entering a negative value in the MotionBlur tab's motionblur control caused Nuke to
crash.
• BUG ID 42078 - exrReader/exrWriter: Multi-part files were not written correctly. Layer names were written into
channel names, rather than part names.
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• BUG ID 42263 - Documentation: The description of STMap was incorrect in the documentation.
• BUG ID 43142 - CameraTracker: Tracking low contrast source images occasionally caused Nuke to crash.
• BUG ID 43498/43584 - ZDefocus: Animating the focus plane or maximum controls caused aliasing/jumping in
the output image when using a disc image attached to the image input.
• BUG ID 43607 - Mac OS X 10.10 (Yosemite) only: Double-clicking the NukeX dock icon launched standard Nuke.
• BUG ID 44351 - Dope Sheet: The time required for frame mapping increased dramatically with branching node
trees.
• BUG ID 46324 - ZDefocus: With the math control in the ZDefocus properties set to depth, objects that were
infinitely far away were incorrectly treated as infinitely close.
• BUG ID 46545 - Issue Reporter: You can now specify where reports are written to by default using the FN_CRASH_
DUMP_PATH environment variable.
• BUG ID 46579 - exrWriter: Writing out multi-part, stereo .exr files inverted the left and right views when the right
view was the hero.
• BUG ID 47602 - VectorBlur: The alpha channel was not taken into account when method was set to backward
and alpha was enabled.

Known Issues and Workarounds
This section covers known issues and gives workarounds for them, where appropriate.

Known Issues Specific to 8.0
BlinkScript/CUDA
• BUG ID 44138 - BlinkScript: float3x3 and float4x4 matrix constructors currently produce a GPU compliation error.
As a workaround, you can pass the following in as a kernel parameter:
float matrixData[] = {1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1};
float4x4 matrix;
m.setArray(matrixData);
• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when
the OS wakes up from sleep mode.
• BUG ID 42111 - BlinkScript: Recompiling kernels when the called function declares a variable with exactly the same
name as a scoped variable in the caller function, returns garbage data.
To work around this issue, make sure that all variable names are unique before compiling the kernel.

CameraTracker
• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez modes.
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• BUG ID 40092 - Stereo: Tracking progress hangs at 100% when Source is set to Stills in stereo scripts.
• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference
thumbnails, rather than just the RGB values.

Deep
• BUG ID 43383 - Executing a script in terminal mode that reads in a deep image then writes it to disk, causes Nuke
to crash.
As a workaround, run the script from the Script Editor inside Nuke.
• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.
As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet
• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you execute
Analyze Sequence with the Dope Sheet open.
• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.
• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from the Dope
Sheet.
• BUG ID 39338 - Clicking the Move button for a selection and then undoing the move does not work as expected.
• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames when frame snap
is enabled.
• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.
• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to have a nonempty frame expression.
• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.
• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in the Dope
Sheet.

EditGeo
• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on geometry with
animation baked into its vertices.
To update the transform handle, toggle the axis alignment control between object and average normal.
• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to ignore the
EditGeo node.
• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe marker.
• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and corner
vertices.
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Import Nuke
• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command line arguments
unavailable.
As a workaround, preserve sys.argv in another variable before you import Nuke.
• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other applications.
• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is available.

In-panel color picker
• BUG ID 39373 - Modifying the value of the red channel affects green, blue, and alpha as well when the controls are
expression linked.

Linux only
• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.
As a workaround, launch Nuke from the command line using:
LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0
• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

Mac OS X only
• BUG ID 45241 - Mac OS X 10.10 (Yosemite) only: Dragging and dropping media into the Node Graph does not
work as expected.
• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.
• BUG ID 41981 - Licensing: Launching Nuke on new MacPros with multiple Thunderbolt devices may display a
licensing dialog explaining that FLEXlm licensing has been disabled, probably due to having too many ethernet
addresses active on the machine.
Please contact support@thefoundry.co.uk to work around this issue.
• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save
Report.

ModelBuilder
• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.
• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a
ScanlineRender node causes Nuke to crash.

Monitor Out
• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.
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• BUG ID 40905 - Decklink 4k Extreme: Enabling monitor out immediately produces audio interference.
• BUG ID 37707 - Viewing 4k footage through a Blackmagic Design DeckLink 4k Extreme causes Nuke to crash.
• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO
• BUG ID 40033 - Adding an OCIOCDLTransform that references certain .ccc files and clicking select occid causes
Nuke to crash.

Particles
• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not
render all frames to the .nkpc file.
• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is out-of-date
errors for negative frame numbers.
• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off are not reliably
cleared when rendering through ScanlineRender.
• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within
the particle system.

Pixel Analyzer and Scopes
• BUG ID 43485 - Scopes: Disabling Preferences > Scopes > Include viewer colour transform with a scope
present in the workspace causes Nuke to crash.
• BUG ID 39180 - Scopes: Switching to a layout with a scope window, whilst rendering, forces the Viewer bounding
box to 1x1 for that frame.
• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.
• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color
transforms is enabled.

Python
• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes Nuke to crash.
• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the
terminal.
Run the script from Nuke's Script Editor to avoid this issue.
• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.
• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command line.
To workaround this issue, run the Python script from Nuke's Script Editor.
• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports incorrect values.
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As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are currently
selected in the Node Graph.
• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first created if it
has an autolabel.

QuickTime improvements
• BUG ID 40684 - Rendering certain h264 encoded .mp4 files results in color shifts.
• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444.
• BUG ID 40032 - Alexa Pro Res footage returns all options when querying the pixel_format knob to preserve
options for processing, which vary between machines. The options returned are dependent on the machine.
• BUG ID 39405 - The ProRes422(HQ) codec with pixel format set to RGBA_16-bit (b64a) is currently reading in
Gamma2.2, rather than the Gamma1.8 colorspace.

Roto/RotoPaint Open Splines
• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the feather handles
in the Viewer.
• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.
As a workaround, select the shape and then manually change the Properties view control to include both views.
• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.
• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative feather
values.
• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave erratically.
• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects in the hull or
feather.
• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally produces
artifacts in the spline's hull.
• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is set to 0.
• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.
• BUG ID 41445 - Drawing splines with 180º bends causes rendering glitches.
• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight rendering glitches
inside the hull.
• BUG ID 40433 Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly from
one point to the next
• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open Spline and
Bezier tools.

Other Roto/RotoPaint Bugs
• BUG ID 41966 - PlanarTracker: Layers in the shapes list are deselected when changing Roto tool.
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• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint color.
• BUG ID 37062/40607 - Certain scripts cause Nuke to crash when opening the Roto Properties panel.
• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another frame.

ScanlineRender
• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.
• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi
transparent areas.
• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.

Text
• BUG ID 41104 - It is not possible to input additional text or highlight text when TCL expressions are included in the
message field.
• BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer overlay is
disabled.
• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does not work as
expected.
As a workaround, expression link the translate x and y controls separately.
• BUG ID 39483 - Highlighting text in the message field and Viewer is not always synchronized correctly.
As a workaround, scrub the playhead to a different frame to update the highlighted text.
• BUG ID 39414 - Text entry in the message field occasionally requires multiple undo operations to remove text.
• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.
• BUG ID 39271 - Japanese characters cannot be entered directly in the Viewer.
As a workaround, enter characters using the message field.
• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame where the
character no longer exists, results in the transformation being lost.
• BUG ID 39130 - Splitting the message field does not work as expected.
• BUG ID 38789 - Viewer toolbar controls steal cursor focus.
• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.
• BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in the Viewer.

Tracker
• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked
frames.
As a workaround, you can enable full frame processing, though this may increase render times.
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• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor
coordinates to 0,0.
• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.
• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between frames.

Windows only
• BUG ID 44185 - Pasting a file path into Nuke's Script to open file browser and pressing Return occasionally
causes Nuke to become unresponsive or crash.
• BUG ID 41471 - Viewing an .exr through a LensDistortion node is slow to render in the Viewer.
• BUG ID 40762 - Python: The QtWebKit DLL does not load correctly.
• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you use the erase
end of the pen.
• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422 (2vuy) pixel
format due to a bug in the codec, resulting in solid green frames.
As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.
• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node, such as
Primatte or Shuffle, even after the node is removed from the Node Graph.
• BUG ID 30903/35284 - An environment variable, NUKE_USE_FAST_ALLOCATOR, was introduced in Nuke 7 to
address potential problems with rendering or exiting Nuke on Windows. After positive feedback, this is now the
default behavior for Nuke 8.
If you experience problems with memory allocation, you can revert to the Nuke 7 behavior by setting a new
environment variable, NUKE_USE_SYSTEM_ALLOCATOR, to 1.

Miscellaneous known issues
• BUG ID 44170 - VectorGenerator currently produces incorrect output if the input image has overscan or a
bounding box that doesn't match the image format.
• BUG ID 42899 - Denoise: Certain scripts containing Denoise and Copy nodes cause image corruption.
• BUG ID 42339 - The Modo Viewer control scheme (Preferences > Viewers > 3D control type) does not work as
expected.
• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel doesn't work as
expected.
• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.
• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as
the file path to the original.
WARNING: If you save this empty script when the network drive is reconnected, the original is
overwritten.
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• BUG ID 41357 - Writing out multiple frames with OFX plug-ins, such as Reduce_Noise, renders more slowly in Nuke
8 than previous versions.
• BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on the Target for
.mov clips with a frame range offset.
• BUG ID 41032 - Disconnecting the image input at the top of a node tree containing a Denoise node upstream of an
OFX node causes Nuke to crash.
• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly in Nuke 8 than previous versions.
• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes correctly.
• BUG ID 40354/42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion, perform
poorly when they are downstream of nodes using PlanarIop, such as Denoise.
• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.
• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-mouse button,
pastes values into the control.
• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the Nuke<>Mari bridge
won't work unless all instances of Project3D are renamed appropriately in the mari_bridge.py file.
• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from
Node Graph.
• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect whilst
toggling the read transform from file in combination with all objects and/or read on each frame.
• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format sizes causes
corruption and constant refreshing in the Viewer.
• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in
error when the path doesn't exist:
Flipbook render failed: viewerCaptureOp: Cannot write to specified path
• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images.
• BUG ID 35614 - For EXR 2.0 files to be backwards compatible with earlier readers, the layer names must not exceed
32 characters in length.
As a workaround, open the .exr in Nuke 8.0 and manually (or Pythonically) truncate the names to allow for legal
backwards compatibility.
• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a superfluous main
view.
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Other Known Issues
AudioRead
• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled between file and
custom.
• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.
• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.
• BUG ID 18451 - Flipbooking doesn't honor the time range knob.
• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.
• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves correctly.

FrameCycler
• BUG ID 17199 - There aren't appropriate LUTs in 6.2v3 for flipbooking some colorspaces including rec709, Gamma
1.8, Gamma 2.2, Panalog, REDLog, ViperLog and REDSpace. As a workaround, you need to select Burn in the LUT
in FrameCycler for an authentic color reproduction.
• BUG ID 15204 - There are currently some graphical glitches occurring when flipbooking certain images. The
workaround is to change the cache precision in FrameCycler. To do this, bring up the settings menu in FrameCycler
(press S), go to Options > Cache and change the Cache precision option to either 16 bit float or 8 bit int + 16
bit float.
• BUG ID 15046 - Flipbooking to FrameCycler with images greater than 4K in width, and with a non-1 pixel aspect
ratio, skews the images (in FrameCycler). This is an issue with FrameCycler 2009, and we are awaiting a fix.
• We direct FrameCycler to write to the user’s Nuke temp directory (NUKE_TEMP_DIR) for its user settings files. You
can redirect this by modifying the FrameCycler/settings/Global_Settings.xml file that can be found within your
Nuke installation.
• Flipbooking with FrameCycler 2009 may not work on some older Intel and AMD processors with certain graphics
card configurations. You can set the FC_PATH environment variable to point to a previous version of FrameCycler
(that is FrameCycler 2008 found in Nuke 6.0v7). For information on setting environment variables, please refer to
the Configuring Nuke chapter in the Nuke User Guide.
For example, you can point FC_PATH to the following locations (check the correct path to the installation on your
machine):
• Mac:
/Applications/Nuke6.0v7-32/Nuke6.0v7.app/Contents/MacOS/FrameCyclerOSX/bin/FrameCycler
• Windows:
Program Files\Nuke6.0v7\FrameCycler\Windows\bin\FrameCycler.exe
• Linux:
/usr/local/Nuke6.0v7-32/FrameCyclerCentOS4.4/bin/framecycler
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NOTE: Please contact support@thefoundry.co.uk if you need older versions of The Foundry software.

Linux only
• BUG ID 31431 - Linux only: The current version of the FFmpeg library used by Nuke reads the height of HD .mov
files at 1088, rather than 1080.
As a workaround, use a Reformat node to force the input to the correct format.

Mac OS X only
• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than one instance of
Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to
occur on GPUs with low amounts of RAM, such as the GeForce GT 650M.
As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one
instance of Nuke at a time.
• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure X11 is installed
on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default.
For more information, see http://support.apple.com/kb/HT5293.
• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.
As a workaround, either:
• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or Samba, depending
on source), or
• using the command line, copy the installation from Mac OS X to the network location using the same file
system as the destination.
• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.
As a workaround, adjust the Viewer gain control to refresh the Viewer.
• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when
Nuke is run from the command line.
• BUG ID 13638 - The following graphics cards are not currently supported for Mac:
• ATI Radeon X1600
• ATI Radeon X1900
Users with these cards will be able to render from the command line, but in GUI sessions, the Node Graph will
render incorrectly due to a requirement of OpenGL 2 drivers.
• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.
• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

Particles
• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
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• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.
• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid
lines.

PlanarTracker
• BUG ID 33254 - PlanarTracker’s Roto node defaults to the Select all tool rather than Bezier. If you click on the
Viewer, then change the tool and draw a shape, your shape is added to the root layer instead of
PlanarTrackerLayer1. This means it’s not considered for tracking, and tracking fails.
The workaround is to:
• make sure PlanarTrackerLayer1 is selected in the Roto Properties,
• change to one of the shape tools before attempting to draw in Viewer, and
• in the Roto Properties, make sure a purple rectangle appears in the PT column to indicate that the shape is
considered for tracking.
• BUG ID 19683 - After adjusting the planar surface using the Correct Plane Viewer button, you have to undo twice
for the planar surface to return to its original position.
• BUG ID 19563 - Detected or tracked features are not offset by the origin of the input image's bounding box.
To avoid this, you can add a Crop node before PlanarTracker’s associated Roto node.
• BUG ID 19240 - When Viewer downrez is greater than 1, the clearTrackDataForward button currently offsets
bezier shapes to fit the root format.
To return the shape to its original size and position, advance the sequence one frame.

PrmanRender
• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-in when in GUI
mode.
See http://support.apple.com/kb/HT5281 for more information.
As a workaround, set the following environment variables:
export RMANTREE=/Applications/Pixar/RenderMan.app/Versions/RenderManProServer-15.1
export DYLD_LIBRARY_PATH=$RMANTREE/lib
Then launch Nuke from the command line.
• In the Nuke camera, the window roll control is not yet mapped to RenderMan.

Python
• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at default (True)
may crash when too many node control panels are created too quickly. The workaround is to pass the in-panel
argument as False or else use nuke.nodes.NodeClass() (where NodeClass is the type of node to create) to create
the node and then connect it to the currently selected node manually.
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• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the Script Editor as
that can cause Nuke to crash. Instead, you can use the same command from your menu.py, restore layouts by
selecting Layout > Restore Layout, or use a custom menu or toolbar item.
• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:
groupName.NodeName.knobname: unexpected 'k' in '0.knobname'
The problem is most likely that there is an expression that is using the input TCL command and doesn't validate
that there is an input connected. An example expression:
[input parent 0].translate.x
The input command returns 0 when it can't find the requested input, which generates an expression of
'0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the value TCL
command and specify a default value to return in the case that the expression is invalid. It takes the form:
[value [input parent inputnumber].knob defaultValue]
Here is the modified example:
[value [input parent 0].translate.x 0]
The modified example returns 0 in the event that there is no input 0, and no longer result in an error message.
• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>() if the knob is
called 'in'.
For example, this gives a syntax error:
nuke.nodes.Shuffle(in = 'depth')
while this works because 'in' is a string here and not a keyword:
sh = nuke.nodes.Shuffle()
sh['in'].setValue('depth')

QuickTime ProRes 4444
• BUG ID 17360 - Some customers have experienced unexpected shifts in chroma values when using the ProRes
4444 .mov codec.
A possible workaround is to modify the GlobalSettings.csv found in the following locations:
NOTE: Please be aware that this workaround is not reliable in every case.
Mac OS X
/Applications/Nuke7.0v6/Nuke7.0v6.app/Contents/Resources/
Windows
C:\Program Files\Nuke7.0v6\
Add the following lines to the bottom of the .csv file:
# Apple ProRes 4444
encode,ap4h,appl,any,any,512
decode,ap4h,appl,any,any,512

14

RELEASE NOTES FOR NUKE 8.0V7B16 | KNOWN ISSUES AND WORKAROUNDS

Render codecs
There have been issues where rendering with certain codecs makes Nuke crash. Due to this, we recommend the
following:
• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec instead. If you're
unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance.
• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or above. You may
need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.
• If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint
• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe
creation.
• BUG ID 32450 - RotoPaint Stereo: Attempting to undo mulitple split-control transforms on the same shape reverts
the shape to its original position.
• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame, disappear
when drag-selected.
As a workaround, select the shape in the curves list to re-display the points.
• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.
NOTE: This also applies to SplineWarp matrices.
• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a
single smooth operation.
• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.
• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in
mind that they won’t be backwards compatible with Nuke 6 once converted, unless you follow the instructions
below:
Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:
• Click Save As to convert the script to the Nuke 8 Roto format, or
• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:
- You don't intend to make any changes, or
- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.
If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or convertDirectoryToNuke6 Python
functions when running Nuke 8 in terminal only mode:
NOTE: The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6.
• To convert individual .nk scripts:
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convertToNuke6(fromScript, toScript, overwrite = False)
• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite = False)
NOTE: The pattern is a regular expression.
An example single script conversion and rename to the same directory, from the command line (terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t
>>> import nuke.rotopaint
>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)
• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and have been
disabled.
The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) hotkeys or the Edit menu instead.
• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.
• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of the screen.
• The foreground onion skin overlay updates as you paint. This will change so the overlay only updates with the new
stroke on pen up.
• It is not currently possible to clone RotoPaint nodes.
• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled on the layer
you are working in.

Tracker
• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.
• BUG ID 32353/32359 - Right-clicking on a point in the Viewer doesn’t always update the available Link to >
Tracker linkingdialog or Tracker options.
As a workaround, close and re-open the Roto/RotoPaint Properties panel to update the Link to menu.
• BUG ID 30116 - Adding tracking anchors with an OFlow node upstream of the Tracker causes Nuke to become
unresponsive.
• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.
As a workaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers
• BUG ID 32340 - SplineWarp: Ctrl/Cmd drag-creating rectangles and ellipses doesn't display an overlay until pen-up.
• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which
cannot be undone.
• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive to when control points are removed.
• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be
undone.
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• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to a new layer.
• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the
cropped image and the black area between the crop box and the format when merged over a background.
• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines.
• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set at an
intermediate value.
• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering
problems.
• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode with mix set
at an intermediate value.
• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather than just the
latest, and the keyframes remain on the timeline and in the Properties pane.
• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.
• BUG ID 19079 - SplineWarp: The C hotkey does not currently select the Add Correspondence Point tool.
• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is
not visible in the Viewer.
• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not
undo as expected.
• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet.
• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the
Draw Boundary Viewer button.
• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A shortcut.
• BUG ID 18012 - GridWarp: The grid can flicker between white and grey when zooming in and out of the Viewer,
particularly when the grid is subdivided.
• BUG ID 17697 - GridWarp: In stereo mode, the right view is labelled as default when you split controls into
separate views.

Windows only
• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous known issues
• BUG ID 39365 - The Viewer Properties headlamp control can not currently be managed using expression links.
• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.
• BUG ID 35976 - Some CUDA code runs in render mode, even when the --gpu argument is omitted.
• BUG ID You can disable all CUDA code by setting the FN_NUKE_DISABLE_CUDA environment variable to 1.
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• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces,
leaving gaps in certain circumstances.
This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the
geometry.
• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when mousing over the
Viewer.
• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.
• BUG ID 32628 - DeepToPoints: Command line rendering appears to calculate renders even when render is set to
off.
• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and Hiero.
• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces
corrupt output.
As a workaround, shuffle the depth information to an alternate layer.
• BUG ID 32118 - Card3D: When motionblur is enabled in the Properties panel, FrameHold and TimeOffset nodes
are ignored when connected to the cam or axis inputs.
• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current frame, not the
entire expression.
• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding
boxes for polymesh primitives.
• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.
• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier, causes the cache to
release. Actions such as adjusting the Viewer Gamma, Gain, or channels dropdown affect the frame hash.
• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.
NOTE: This known issue only applies to Roto and SplineWarp keys.
• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is
copy/pasted in the Node Graph.
• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.
• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only
displays the animated Camera in the Viewer. There should be two cameras: one static and one animated.
• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the
new camera does not match that of the Viewer camera.
• BUG ID 29048 - OCIO: Using the ocionuke library in terminal mode results in an error.
• BUG ID 28291 - Nuke crashes on startup if the disk cache location set in the Preferences is no longer available.
• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files.
As a workaround, ensure that ReadGeo > read on each frame is enabled.
• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the
project, subsequent reads of any stereo/multiview .exr files won’t give the option to add new views.
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• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel open.
• BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing downrez in
the Viewer toolbar can cause textures to flicker in the 3D Viewer.
You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.
• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer.
• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the
Properties pane.
• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.
• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because some large
polygons are clipped by the front camera plane.
You can minimize this effect by increasing the geometry tessellation max parameter.
• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or zooming.
• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and points drawn
with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and the other in 3D mode, and you
have the panel for the RotoPaint visible.
• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit per frame is
50MB. If your frames are larger than this, you may need to switch to proxy mode for the caching to work.
• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is not restricted
to, any nodes that have an analysis pass.
• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.
Nuke runs correctly from a network install on Windows without specifically installing the run-time libraries, though
we still recommend that you do so as there will still be some minor problems without them. For details, please see
Installation on Windows in the Installation and Licensing chapter of the Nuke User Guide.
• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render. This question is
unnecessary as the result is an anaglyph image. Irrespective of what view you choose, the flipbook output is the
same.
• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so if you save a
script on NukeX using features that are only included in NukeX (such as CameraTracker or FurnaceCore) and then
double-click on the script icon to open it, it will open in standard Nuke instead of NukeX.
• If you have trouble with FBX files, it may be because they were written with an older version of FBX. If they load
very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the
FBX converter on the Autodesk web site. It converts between various different formats, including older FBX
versions, ASCII, and binary, and is available on Windows, Mac OS X, and Linux.
To download the FBX converter:
1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.
2. Scroll down to FBX Converter and click on one of the links to start the download.
• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.
• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node when using
Create Scene:
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• Select the Camera that was created in the 3D view when using the Create Scene button.
• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to focus (using F) on
the point cloud. The resulting tumble camera movement is likely to be jumpy.
• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were complied against an earlier
version of Nuke.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar for more
information.
NOTE: Node Class() names occasionally change between major releases, such as Nuke 7 to Nuke 8. While
these changes do not affect legacy scripts, you may not get the results you were expecting if a node class
has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node
class names and is located in <install_directory>/plugins/nukescripts/ for reference.
As an example, between Nuke 7 and Nuke 8, the Text node Class() changed from Text to Text2. In the
toolbars.py file for the two releases, the entries for the Text node appear as follows:
m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png")
m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png")

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.

Bug Fixes
• BUG ID 42842 - Calling unsplitView() with a stereo 3D camera in a customer script caused Nuke to crash.
• BUG ID 46069 - Knob defaults were ignored for the Root node when executing a .py script in Nuke -t mode.
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